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USING THIS GUIDE AND DDDL ON-LINE HELP  
 
The material in the printed guide was designed as a convenient basic reference for the main features of the DDDL 
software.  It is based primarily on the contents of the on-line Help contained in every copy of DDDL software.  The 
material in the printed guide is arranged according to the drop-down menu structure of the program, starting with the 
“Calibration” drop-down menu and proceeding through the “Tools” selection.  While most of the DDDL features are 
included, the comprehensive Help section contains a great deal of information not covered in the basic printed guide.   
 
Note: The screens you will see when you follow this guide on your PC may vary depending on the version 
of DDDL you have.  
 
For those users not familiar with using Windows based Help files please take some time to review the material in this 
section.  You may access the on-line help section by going to the “Help” drop-down menu in the Diagnostic Link program 
and selecting “Help Topics”.  The initial screen that comes up will be: 
 

 
Understanding how the three tabs (Contents, Index, and Find) at the top of Help window work will greatly enhance your 
ability to quickly find information on the specific topics.   
1. Using Contents:  

a. The book icons in the “Contents” tab can be opened to reveal their contents by a left mouse double click on the book 
you wish to open.  You may close an open book with a left double click as well. 

b. Notice that in Step 2 above, opening the book, “Detroit Diesel Diagnostic Link,” opens up to three more books of 
information.   

c. If we open up book two “DDDL Windows and the Toolbar” you’ll find that it contains five topics (listed in Step 3).  
The question mark indicates that these listings can be opened for information on that particular topic but it contains no 
more sub-topics.  
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2. Using the Index 

Choosing the “Index” tab will reveal the following screen: 

The “Index” is an alphabetical listing of the topic titles in DDDL Help.  The “Index” is not the most useful way to search 
for help on a particular word.  If the word you are looking for is not the first word in the topic title, your search will come 
back without finding anything.  For example, if you are looking for information on setting the ECM clock and type in the 
word “clock “ you will get an unsuccessful search.  If you typed in “set” you would be successful because the topic is titled 
“Set ECM Clock”.  If you want to find help on a topic with a key word you are better off using the “Find” tab. 
 
3. Using Find: 

The first time you access the “Find” selection, you’ll get a dialog box asking you to set up the information database: 
You may choose the level of search capability you wish to have.  Another screen will appear while the setup process is 
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completed.  (This process only happens the first time that you use “Find.”)  The next screen to appear will be the normal 
“Find” screen.   This is the most powerful of the three tabs when it comes to locating assistance in Help. 

  To use "Find" effectively, follow the steps below: 

a. Simply type in the key word you want information about into section 1.   As you type, the search mechanism begins to 
locate all the DDDL Help topics containing this word.  All the topics containing the key word are listed in section 3. 

b. You may select words to refine the search by clicking on matching words in section 2.  This may narrow your search 
and eliminate some of the topics listed in section 3. 

c. Scroll down through the list of topics in section 3 using the arrows on the right side of the box until you find the topic 
most likely to contain information on the subject.  Highlight the topic you wish to examine with a single left click of 
your mouse then, choose the "Display" button. 

 
4. Additional Notes on Help for DDDL 5.0 and Later 
 
DDDL 5.0 was the first version to support both the DDEC and MBE electronics systems.  The documentation now reflects 
the support multiple systems.   

 
If a feature is common to both systems the differences are also explained in Help. 

 

While many features work with both the 
DDEC and MBE system, those features 
that work with only one system will be 
identified in the section heading.   
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DROP-DOWN MENU SELECTIONS FOR DDDL 6.3 (DDEC FUNCTIONS) 
 
File   Calibration   Snapshot        
Open                               Passwords   New 
Save   Retrieve    Open 
Save As    Injector    Close 
Save Fleet Cal  Rating    --------------                
Close    -------------                    User Event 
-----------  Audit Trails   Pause   
Print   ECM Set Clock   Snapshot to CSV 
Print Preview   
Print Setup         
-------------    
List of Recent Files      
-------------- 
Exit    
  
     
 
Diagnostics   Tools                    Window 
Fault Codes                    Engine/Trip Data                Cascade 
Cylinder Cutout   ---------------------   Tile     
 ------------------------  DDEC Reports   Arrange Icons 
Diagnostic Instrumentation ---------------------                 
Normal Instrumentation  Clear AFR Learn Table 
--------------------------  Particulate Filter De-green Reset 
Engine Configuration Data              Recalibrate NG Oxygen Sensor 
ECM I/O                                          Recalibrate EGR DP Sensor 
Injector Response Time  Options 
-------------------------- 
Maintenance Alert 
View Observed Mids 
Exhaust Backpressure Fault Times 
 
 
Help 
Help Topics 
----------------------- 
DDEC II, III, IV Troubleshooting 
DDEC V Troubleshooting 
DDC Mechanical Troubleshooting 
------------------------ 
MBE Electronic Troubleshooting 
------------------------ 
About Detroit Diesel Diagnostic Link 
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DROP-DOWN MENU SELECTIONS FOR DDDL 6.3 (MBE FUNCTIONS) 
Available MBE functions are in bold type 
 
 
File   Calibration   Snapshot        
Open                               Passwords   New 
Save   Retrieve   Open 
Save As   Injector    Close 
Save Fleet Cal  Rating    --------------                
Close    -------------                    User Event 
-----------  Audit Trails   Pause   
Print   ECM Set Clock   Snapshot to CSV 
Print Preview   
Print Setup         
-------------    
List of Recent Files      
-------------- 
Exit    
  
     
 
Diagnostics   Tools                    Window 
Fault Codes                    Engine/Trip Data  Cascade 
Cylinder Cutout   ---------------------   Tile     
 ------------------------  DDEC Reports   Arrange Icons 
Diagnostic Instrumentation ---------------------                
Normal Instrumentation  Clear AFR Learn Table 
Engine Configuration Data Particulate Filter De-green Reset 
Activate Outputs  Recalibrate NG Oxygen Sensor 
Service Routines   Recalibrate EGR DP Sensor 
    --------------------- 
------------------------  Options 
Maintenance Alert 
View Observed Mids 
Exhaust Backpressure Fault Times 
 
 
Help 
Help Topics 
----------------------- 
DDEC II, III, IV Troubleshooting 
DDEC V Troubleshooting 
DDC Mechanical Troubleshooting 
------------------------ 
MBE Electronic Troubleshooting 
------------------------ 
About Detroit Diesel Diagnostic Link 
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USING THE CONNECT ICON ON THE TOOLBAR 
 
While the features in this document are normally located by their position in the drop-down menus, there is one option that 
exists only as an icon on the toolbar: the connect icon.   In the past users who had selected certain interface choices could 
only run the DDDL application when hooked up to a “live” ECM.  If they tried to open the application when not connected 
to a vehicle the program would stop loading, an error message would be displayed, and the user would be sent back to the 
Windows desktop.   
 
1. In DDDL 4.2 or later the user will now get the following message: 
 

 
 
2. When the user acknowledges the message the program will continue to load and the user may work in an offline mode.  
If the user wishes to connect to a vehicle later in the session he can do so without re-starting the application by selecting the 
new connect icon in the toolbar. 
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USING PASSWORDS IN DDDL  
ECM settings are protected by passwords.  When using Detroit Diesel Diagnostic Link to change settings, you must enter 
the appropriate password within the program before you can transmit the changes to the ECM.   There are four different 
types of passwords for DDEC.  For the MBE system VCU software level 13 and later supports a calibration password to 
protect all VCU parameters.  When you go to the DDDL calibration drop-down menu the “Passwords” selection is now 
active and this Window will appear when it is selected.  Beginning with DDDL 6.0 there is a backdoor password access 
function for both DDEC V and the MBE calibration passwords. 
 
1. The Calibration Password is used to protect most of the calibration settings in the ECM.   
 
2. The Ratings Password gives additional protection to the rating setting.  The rating you choose can have major 

consequences on engine life as well as performance.  You must enter both the calibration and rating passwords to 
change the rating.   

 
3. The Group Lockout Password allows an administrator to choose specific parameters for protection with an extra 

password.   You must enter both the calibration and function lockout passwords to change the functions locked out. 
 
4. The Injector Calibration password protects the flow calibration of the injectors. 
 
5. The Backdoor Password function generates a special code to be used in conjunction with your local DDC distributor 

or DDC technical service to unlock forgotten passwords in DDEC V or MBE systems. 
 
CHANGING THE CALIBRATION PASSWORD (DDEC) 
 

 
The calibration password enables you to change the calibration in an ECM but not the engine rating or function lockout. To 
change it: 
 
1. Choose Passwords from the Calibration menu to display the Change Password dialog box. 
 
2. Type the old password into the Old Calibration Password box.  For password security, the numbers you type will not 

be shown on the screen when you type in passwords.  Only “*” symbols will appear. 
 
3. Type the new password into the New Calibration Password box. 
 
4. Type the new password into the Confirm New Password box to verify that you typed it correctly. 
 
5. Click on “OK” to close the dialog box and set the new password. 
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CHANGING THE INJECTOR CALIBRATION PASSWORD (DDEC ONLY) 
The Change Injector Password dialog box is displayed when you click on Change Password in the Injector Calibration 
dialog box. 

 
1. Type the old password into the Old Password box.  For password security, the numbers you type will not be shown on 

the screen when you type in passwords.  Only “*” symbols will appear.  
 
2. Type the new password into the New Password box. 
 
3. Type the new password into the Confirm New Password box to verify that you typed it correctly. 
 

4. Click on “OK” to close the dialog box and set the new password. 

CHANGING THE RATINGS PASSWORD (DDEC ONLY) 
To change the password that enables you to alter the engine rating:  
 
1. Choose Passwords from the Calibration menu to display the Change Password dialog box. 
 
2. Click on the Ratings Password radio button to open the dialog box entering a new ratings password. 

3. Type the calibration password into the Calibration Password box. 
 
4. Type the old ratings password into the Old Rating Password box. 
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5. Type your new password in the New Rating Password box. 
 
6. Type the new password into the Confirm New Password box to verify that you typed it correctly. 
 
7. Click on “OK” to close the dialog box and set the new password. 

SETTING THE GROUP LOCKOUT PASSWORD (DDEC ONLY) 
To change the password that enables you to lock out (protect from being changed) selected calibration functions: 
 
1.  Choose Passwords from the Calibration menu to display the Change Password dialog box. 
 
2. Click on the Group Lockout Password radio button to change the dialog box so that you can enter a new group lockout 

password: 
 

 
3. Type the calibration password into the Calibration Password box. 
 
4. Type the old group lockout password into the Old Lockout Password box. 
 
5. Type the new password into the New Lockout Password box. 
 
6. Re-type the new password into the Confirm New Password box to verify that you typed it correctly. 
 
7. Click on “OK” to close the dialog box and set your new password. 
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USING FUNCTION LOCKOUT  
(WITH DDEC III REVISION 4.0 AND LATER SOFTWARE) 
 
The Lockout tab in the Calibration window allows you to protect certain functions in the ECM. These functions can only be 
changed if you enter the function lockout password in addition to the calibration password. 

 
If the ECM supports function lockout, the Lockout tab will show the current lockout settings when the calibration is 
retrieved from the ECM. 
 
The settings in the Lockout tab affect the settings you are allowed to make in other tabs.  If the lockout tab shows you are 
locked out of a particular function, you will not be able to change it.  
 
To change the functions locked out in the ECM: 
 
1. Type the lockout password into the Group Lockout Password box. This enables the check boxes in the tab.  You will 

check and uncheck boxes by clicking on them with the left mouse button. 
 
2. Put a check mark in the box of any function you want locked out.  Make sure there is no check mark in the box of any 

function you want to allow others to change. 
 
3. Enter the calibration password in the Password box. 
 
4. Click on “Transmit” to send the new lockout settings to the ECM. 
 
Note that the group lockout password unlocks all of the functions, so once you have entered it, you can change any of the 
calibration settings in the other tabs, whether they are locked out or not. 
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USING THE BACKDOOR PASSWORD FUNCTION FOR DDEC V  
 
In prior versions of DDEC backdoor passwords have been generated through a process not involving DDDL. Beginning 
with DDEC V there is a new process where information from DDDL will need to be supplied to your DDC Distributor or 
DDC Technical Service in order to generate a backdoor password.  Follow these steps to generate a backdoor password for 
DDEC V: 
 
1. Write down the full engine serial number displayed in the “Engine Configuration Screen” when you first connect with 
DDDL. You’ll need this information later. 
2. From the Calibration drop-down menu, choose the “Passwords” selection, and then choose the “Backdoor” option in the 
lower right side of the screen. 
3. A screen will appear with a number as shown below: 

 

            
              
 

Follow the on-screen instructions. When you have the backdoor password you may insert it for any function that 
calls for a password.  

 
Please note that this password will only be good for one engine hour. Once a change in engine hours occurs a new 
password must be generated.   
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THE CALIBRATION PASSWORD FOR MBE 
 
VCU software 13.xx and 14.19 allowed users to set up VCU password protection. This password option protected all 
parameters in the VCU with a single password. Beginning with version 14.20 users may now protect certain parameter 
groups with an additional password levels.  
 

                          
 
 
Special Note: VCU software versions prior to 13.xx contained no password options. 
The levels available and the parameters they protect are: 
Level 1 – All VCU parameters 
Level 2 – Maintenance Alert / Optimized Idle parameters 
Level 3 - Low Gear Torque Limiting and Progressive Shift 
Level 4 – Limiters (Parameter Groups 3, 5, 6) 
Level 5 – PTO / Idle Shutdown parameters 
Level 6 – I/O Configuration, Engine Protection, Fan Control, Engine Brake, Trans 
Type 
Level 7 – TBD at a later date 
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To set up any of the above levels of password protection for a VCU select the calibration drop-down menu and choose 
“Passwords” 
 

 
 
You’ll be taken to a the password setup screen: 
 

 
 
MBE passwords may be up to 10 numbers. There are no letters allowed.   
 
In using the password management screen the “Old” password will be grayed and only the “New” and “Confirm New” 
boxes will be active is a password for this level has not yet been set.   
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If there is already a password set for a particular level, you will need to enter the old password before being able to change 
to different password. 
 

 
 
When making changes to a VCU parameter with more than one password level, the user will be prompted to enter both 
passwords before sending the change. 
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USING THE MBE BACKDOOR PASSWORD FUNCTION 
 
There are occasions when the existing password needs to be bypassed. It may be a case of the password being forgotten or a 
used vehicle has been purchased with an existing password. To get the “Backdoor” password to bypass the existing 
password follow these steps: 
IMPORTANT NOTE: ONCE YOU HAVE BEGUN THE BACKDOOR PROCESS DO NOT TURN OFF THE 
IGNITION. THE NUMBERS YOU ARE GENERATING WILL CHANGE AND YOU WILL HAVE TO START 
OVER. 
1. Write down the full 14-digit engine serial number displayed in the “Engine Configuration Screen” when you first 
connect with DDDL. You’ll need this information later. 
2. From the Calibration drop-down menu, choose the “Passwords” selection, and then choose the “Backdoor” option in the 
lower right side of the screen. 
3. A screen will appear with 2 numbers: 

 
           
4. You now need to contact your local Detroit Diesel distributor or Detroit Diesel MBE Technical Service person with the 
complete engine serial number, the 2 numbers in the Backdoor password box. They will be able to provide a number to 
place in the section for unlocking the module. 
5. When the password has been entered, click on the “Submit” box and you should see the following message: 
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CHANGING DDEC CALIBRATION PARAMETERS 
 
DDDL is equipped with capabilities to reprogram portions of the calibration in the ECM.  The following list contains many 
of the parameters that may be adjusted with DDDL.  Parameters on this list may be revised in new releases of ECM 
software. 
 

- Change DDDL calibration configuration password 
- Add and or delete idle shutdown; set the idle shutdown timer 
- Change droop 
- Set the initial speed if cruise control switches are used as a power take-off option 
- Set VSG droop 
-Enable and or disable cruise control 
- Add and or delete a vehicle speed sensor 
- Change vehicle speed limit 
- Change cruise control speed limit 
- Reconfigure engine protection features 
- Set VSG maximum speed 
- Switch between available engine ratings 
- Enter injector calibration 
 

THE DDEC CALIBRATION WINDOW 
 

 
The Calibration window is displayed when you choose New or Open from the File menu to create a new calibration or open 
a previously saved one, or Retrieve in the Calibration menu to download the calibration from an ECM connected to your 
PC.  The window allows you to examine and set the calibration of an ECM connected to your PC.  The calibration window 
has a number of different pages labeled by tabs at the top of the window: 
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Note that the calibration parameters available depend on whether you are using a DDEC II, DDEC III, DDEC IV, or DDEC 
V.   Note also that for DDEC III the Vehicle Unit Number is separate from the Vehicle Identifier that you can set and view 
in Detroit Diesel Communications but that they are the same for DDEC IV and V. 
 
The controls may be: 
 
1. Enabled and editable - The values are shown as black text against a white background with a black caption  
 
2. Enabled and read only - The values are shown as black text against a gray background with a black caption  
 
3. Disabled - The values are blank against a gray background with a dark gray caption  
 
Controls may be disabled if you are connected to an ECM that does not support that feature or if it depends on some other 
control, such as a check box, that has not been selected. 
 
To view the different pages of data shown in the window: 
 
Click on the tab labeling the page holding the data group, or hold the Control key down while you press the number key 
shown on the tab. 
 
To close the Calibration window:  
 
Press Close or choose Close from the File menu. 
 
Although they are concerned with different types of data, you will use the same techniques to set values in most of the 
pages.  Rather than presenting separate details for each page, changing the Calibration gives you general instructions for 
changing the calibration.  Please note the Lockout tab is different and is described separately. 
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CHANGING MBE CALIBRATION PARAMETERS 
 
 The MBE Calibration Window 
 
There has been a major change in the way parameter changes are to be made in DDDL 6.0 and in all future versions of 
DDDL in the MBE calibration window. When you retrieve a calibration from an MBE engine the parameters will no longer 
be divided into groupings on separate tabs but only appear as a numerical list of parameter groups. You may navigate 
through the group structure in much the same way that you navigate through the folder structure in Windows Explorer. The 
figure below shows a slice of the retrieved calibration.  

 
To get to the parameter value you wish to change, scroll down the group list till you find the group you wish to work with 
and click on the “+” in front of the group name. The parameters in this group will become visible; the key 5-digit number is 
displayed to the left of the parameter name.  Parameters displayed in lighter gray type are for informational purposes 
only. Parameter settings that may be changed are in black type.  Parameters for the PLD and VCU are identified using 
specific numbering system.  Parameter settings are normally referred to by a five-digit value such as 10202.  The parameter 
list in DDDL contains settings for the both the PLD and VCU (for complete parameter lists of PLD and VCU default values 
see the MBE Electronic Controls Information appendices). To understand what the values in the 5 digit parameter number 
represent please review the figure below: 
       
 
                                     
 
 
 

                                               
 
To change a parameters click on the “Value” column and insert the numerical value or select the choice from those in the 
drop-down menu that appears.  
 

   
      
 
 
 

 

This value indicates 
what group should 
be looked at.                

This value 
identifies if the 
parameter is 
from the PLD 
(0) or VCU (1) 

This is the parameter 
number within the 
group.  
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Follow the figures below to see how the new password feature will appear to users changing parameters.  Retrieve the 
calibration in the usual manner and locate the item (or items) you wish to change, change the figure to the appropriate 
value and click on the “Transmit” box.  
 

 
     

If the password protection feature has been enabled, the enter password window will appear over the calibration list. At this 
point, enter the appropriate password to proceed. Once the password is entered click on the “OK” box.  
 

 
      
If the correct password is entered the password window will disappear while the changes are sent to the controller. This 
window will pop up on the screen for a varying length of time depending on how many changes were made. The user will 
then be prompted by a new dialog box appearing over the calibration list to turn off the ignition. 
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Once the ignition is turned off, a countdown proceeds on the screen until a new screen appears prompting the user to turn 
the ignition back on. At this point the change process is complete. 
 

 
      
After a successful change has been made a screen will appear asking if you wish to save the calibration.  This gives you the 
option to save the calibration to your hard drive. If you don’t want to save the file, click once with the left mouse button on 
the “No” option and the process is complete.  Click once on “Yes” to save the file to the hard drive. Choosing “Yes” or 
“No” to this question has no effect on the change you just transmitted.  It only affects whether you save the contents of the 
calibration as a file on your hard drive.  
 

                                         
      
It should also be noted that the groups and numbers within the groups have changed completely from version 12 to version 
13. The number of parameters that are capable of being changed by DDDL has also expanded with version 13 software. 
The numbering scheme for parameter groupings remains the same in VCU 14 software. Additional features have been 
added to version 14 that have previously been only available in DDEC software including: 

a. Pass Smart 
b. Fuel Economy Incentive 
c. Cruise Power Rating  
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SETTING INJECTOR CALIBRATION CODES (DDEC ONLY) 
 
When new injectors are installed in a service action, you should reset the calibrations for the injectors. 
 
1. Choose Injector from the Calibration menu to display the Injector Calibration dialog box.  It will show the current 

injector calibration values.  Move the up/down arrows of each box to show the new values. 

2. Enter the injector calibration password.   

3. Transmit the changes to the ECM. 

The cylinders for the other ECMs in multi-ECM engines will be shown below the master ECM block cylinders. 

 
SETTING INJECTOR UNIT PUMP CODES (MBE ONLY) 
 
The unit pump on MBE engines has a specific 14-digit value stamped on it as shown below: 
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1. The number has always been on this particular part however with the release of the 2004 MBE engines there is a 
requirement to enter this information when the unit is replaced. You may use do this with the Programming Station, Detroit 
Diesel Diagnostic Link, or the Minidiag. The routine to perform this operation in the Minidiag is called  “Routine 006 - 
pump line nozzle change”.  To enter the value with DDDL choose the “Calibration” drop-down menu and select “Injector”.  

                                
2. The screen to enter the proper value will appear: 
 

                 
 
3. Select the cylinder you will be performing the replacement on and then insert the value shown on the unit pump. It 
should be noted that in that the reference to the cylinder is the cylinder’s physical location and not the firing order. Also 
note that if an incorrect sequence of numbers is entered you may receive a message informing you that an incorrect value 
has been entered. Once the complete value has been entered, click on the “OK” box and you’ll be prompted to recycle the 
ignition so that the change may take effect.  Upon sensing the ignition has been turned off a countdown will appear on the 
screen. 
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When the countdown is complete there will be another message asking you to turn the ignition back on.  When the ignition 
is turned back on the application will display another message informing you that the operation has been successfully 
completed. 

                                          
 
RATING CHANGES (DDEC III / DDEC IV / DDEC V ONLY) 
 
To change the engine rating:  

1. Choose Rating from the Calibration menu to display the Rating dialog box. 

2. Choose the rating from the list available.   

3. Enter the ratings change password. 

4. Transmit the change to the ECM by clicking on the “Transmit” button. 
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USING THE FLEET CALIBRATION (DDEC ONLY) 
 
The fleet calibration (fleet cal) feature allows the manager of a fleet to create one calibration that can be loaded into many 
vehicles of the same configuration. For example, a fleet manager taking delivery of 50 new vehicles and making ten 
changes to the calibration would have to make 500 individual changes with a Pro-Link diagnostic reader. With the fleet cal 
feature, a manager can create one calibration with all 10 changes and make one download to each vehicle, accomplishing 
the same task in less time with greater accuracy. 
 
1. Retrieve the original calibration from the vehicle and save it to your hard drive.  You can now turn off the ignition. 
 
2. Make all the desired changes to the calibration on screen by going from tab to tab and typing in the new numbers. 
 
3. Remove the individual unit number and vehicle ID number in Tab 1, Vehicle. 
 
4. Enter your fleet password in the box in the bottom left corner of the calibration edit screen. 
 
5. Click on the File drop-down menu and select the Save Fleet Cal option.  Save the newly created calibration with a 

name other than name of the original calibration. 
 
6. If you are putting the new calibration into the original truck in the same session, connect the translator box and PC to 

the diagnostic connector.  Turn on the ignition. 
 
7. If you are starting a new session, start DDDL and connect the PC to the truck. 
 
8. Open the fleet cal you just created by clicking on the File drop-down menu and selecting the fleet cal from the list of 

files near the bottom of the menu. 
 
NOTE: A fleet cal can be saved with a specific password.  If the password stored in the calibration file is the same as that 
stored in the ECM and no further changes were made, the calibration could be transmitted by anyone who need not be 
aware of the password in the calibration.  In DDDL versions 3.1 or later, the user may transmit the contents of the fleet 
calibration without overwriting the current vehicle number and VIN number.  In versions of DDDL prior to 3.1, the person 
transmitting the calibration must know the password because the vehicle ID and unit number need to be added and this 
action requires the password 
 
IMPORTANT NOTE: Steps 9 and 10 below must be completed if you use DDDL 3.0 (or prior) to insure the proper 
vehicle ID and VIN number are entered when using a fleet calibration.  The fleet cal feature in DDDL 3.1 no longer writes 
over the vehicle ID or VIN number already programmed into the ECM. 
 
9. After entering the password into the box at the bottom left corner of the window, type the new vehicle ID and unit 

number into the box in Tab 1. 
 
10. Click on the Transmit button at the bottom of the window.  This sends the calibration to the ECM. The process is now 

complete. 
 
DDDL offers a variety of password security features to the fleet manager including Group Lockout and 
Rating Change passwords.  Please refer to specific sections of the Diagnostic Link help menu for more information on these 
topics. 
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USING THE SNAPSHOT FEATURE IN DDDL  
Special Notes:  1. All portions of the snapshot feature perform in the same manner for both the DDEC and MBE systems.  
2. Snapshots created by later versions of DDDL may not play correctly in the earlier versions of DDDL.  For example, a 
snapshot created with DDDL 6.0 will not play in DDDL 4.1. 
 

1. Choose “New” from the Snapshot menu to open the snapshot control window. 
 
2. The snapshot feature begins immediately upon the appearance of the control window. 
 
3. All electronic engine data transmitted during the snapshot is stored for playback. 
 
4. Any codes that occur during the snapshot are automatically marked. 
 
5. You may mark events any time during the snapshot with the user event button. 
 
6. Beginning with DDDL 4.1, the user has the ability to add comments to the snapshot. Click on the “Annotate” button 

and a window will appear allowing additional remarks about the current snapshot. 
 
7. Hit the stop recording button to finish your snapshot. 
 
8. A dialog box appears giving you the opportunity to save your snapshot.  At this point you may choose a name for your 

snapshot and the location to store it. 
 
B.  To open a previously saved snapshot,  

1. Choose “Open” from the Snapshot drop-down menu to display an Open dialog box. 

  2.   See the next section on how to replay the snapshot file.   
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USING SNAPSHOT REPLAY CONTROLS 
When you have opened a snapshot, replay controls will appear at the bottom of the DDDL window you opened: 

 

1. Start the replay of a snapshot by clicking on “Play.”  The play button changes to “Pause” when a snapshot is replaying.  
While the snapshot is replaying, the replay slider next to the Play/Pause button moves showing the progress of the 
replay, and the time box next to it shows the time since the beginning of the recording.  When you click on “Play” the 
snapshot begins to play from its current position and the instruments show the appropriate readings.  The event window 
also changes during the replay to show the most recent event. 

 
2. Stop the replay at a particular point of interest by clicking on “Pause.”  The instruments will show the values at the 

time the replay was stopped. 
 
3. Beginning with DDDL 4.1, additional comments may be added to the snapshot while in replay mode.  Click on the 

“Edit” box and a window will appear to add your remarks. 
 
4. Move to a specific time in the replay by dragging the replay slider button.  As you drag the slider, the time shown in 

the time box changes to reflect the position of the slider. 
 

Or, 
 
5. Move to a specific time in the replay by typing the time you require into the time box.  Make sure you use the same 

format for the numbers as the box displays.   Click on the “Return” key. 
 

Or, to show the data at the time of a specific event, 
 
6. Click on the event drop-down list box to display the list. 

 
The box shows the events generated by the ECM and those marked by the user in the order in which they occurred.  
Select an event to move the replay point to the time at which the event occurred. 
 
If the snapshot is playing when you move to a new position, it will continue playing from the new point.  If the 
snapshot is paused when you move to a new position, the instruments will hold the data for the new position until you 
start playing the snapshot or move to another new position. 
 
NOTE: Not all DDDL windows can be activated when replaying the snapshot feature.  Windows that may be 
activated include: the normal instrumentation window, the diagnostic instrumentation window, the graph 
window, the user window, and the fault codes window.  You cannot access the injector response time window or 
the cylinder cutout window in snapshot mode. 
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CHANGES TO THE GRAPH TAB IN DDDL 6.1 AND LATER 
 
In addition to the feature changes below, the window that displays the numerical values that appear in the Graph window 
now adjusts automatically to allow for more parameters to be viewed at once without scrolling down.  
 
1. Saving User Selections in the Graph Window   
 

 
 
 
 
 
 

 
 
Users choose the parameters they wish to view by clicking on the “Modify” button on the main Graph window and using 
the “Add / Remove” buttons.  When the selections are finalized choose “OK”. 
 

Beginning with DDDL version 6.1 users will be able to save and then load selected groups of 
parameters when using the Graph tab in the Normal or Diagnostic Instrumentation panels. The feature 
will work in the same manner as the “Load” and “Save” feature on the “User” panel.   
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2. Identification of Diagnostic Codes and User Events in the Graph Window When in the 
Snapshot Playback Mode 
 

 
 
Users may now set up their snapshot replay mode so that diagnostic codes and user marked snapshot events will be marked 
along the time-line at the top of the Graph window.  Please note this feature only works with snapshots created with 
DDDL version 6.1 or higher.   
 
 
 
 

If you wish to save this 
selection for future use 
select the “Save” box on 
the main Graph window 
and select a file name in 
the dialog box that 
appears.  The selection 
may be recalled at a later 
time by choosing the 
“Load” box on the main 
Graph window. 
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To activate this feature select the “Modify” box on the main Graph window. When the window appears add the “Active 
Code Count” from the “Available” list of parameters along with the other parameters you wish to select and choose “OK”.  
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USING THE SNAPSHOT TO CSV UTILITY 
 
Beginning with Diagnostic Link version 4.1, this feature allows users to view the raw data captured in a DDDL snapshot 
inside a spreadsheet for advanced engine data analysis.   
 
1. To begin the conversion of an existing snapshot to a comma separated variable data file (csv file), go to the “Snapshot” 
drop down menu of Diagnostic Link and select the “Snapshot to CSV” option. 

 
2. A dialog box will then asking you to identify the snapshot file you wish to convert.  Select the file you wish to process by 
highlighting it and select “Open”. 
 

 
3. When a file has been selected, a new dialog box will appear allowing the user to set up the options for the csv output file.  
The following items must be set up prior to creation of the export:  
 
- Parameters to be listed (the user must specify) 
- Export time interval (if only a portion of the snapshot is to be analyzed), value in seconds; by default the entire snapshot is 
converted 
- Sample frequency (this value may begin at .001 seconds and go up from there); the default interval is one second  
- Sample format (3 types are available) 
- Save-in dialog box to name the final output file and designate its location 
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4. When all these items are selected, click once on the “Export” box, just to the right of the “Save-in” dialog box and the 
conversion process will begin. 

 
 
5. When the export is completed the user will receive the dialog box below asking the user to verify that they want to save 
the new csv file. Click on “Yes” and the process is completed. 

 
Please consult your spreadsheet’s documentation for working with the csv output files. 
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FAULT CODES AND DDDL 
 
DDEC Fault Codes Window 
 
The Fault Codes window is displayed when you choose “Fault Codes” from the Diagnostics menu.  Note that the screen 
below shows the Fault Codes window for a DDEC III, IV, or V.  See the note following the screen for differences when 
you are using a DDEC II. 

 
Fault Codes Window Information (all versions of DDDL) 
- The light bulb symbol on the left indicates if the code is still active.   
- The window displays both the DDEC flash code and the SAE code notation (SID or PID and the FMI).  The engine hour 
when the code first occurred is displayed.   
- If the code is historic, the engine hour when the code last appeared is displayed as well, along with the total duration time 
of the code for all counts logged. 
- You may access the troubleshooting help guide for a particular code by highlighting the code you wish to work on with a 
single left mouse click and then selecting the Troubleshooting Help option.   
 
Fault Code Window Features in DDDL 4.1 and later 
- Time stamps are included for the beginning and ending of each fault code. 
- Current engine hours have been added to the Window. 
- Certain parameters will display a minimum/maximum value attained during the time the code was active. 
 
The Fault Codes window with a DDEC II - The DDEC II ECM does not allow you to clear individual codes, so when 
you are connected to a DDEC II the Clear Inactive Codes and Clear Selected Codes buttons are replaced by a single Clear 
All Codes button. 
 
To clear all the codes from a DDEC II ECM, click on the Clear All Codes button. 
 
Snapshots - If you have opened a snapshot, the replay controls are added to the bottom of the Fault Codes window when it 
is selected.  This way you can monitor fault codes produced during the snapshot.  When the window is used for a snapshot, 
the Clear Selected Codes and Clear Inactive Codes buttons are hidden since these operations are only relevant when you are 
connected to an operating ECM. 
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MBE Fault Codes Window 
 
The information shown in the fault codes window is not a function of DDDL but a function of the information being sent 
by the electronic control unit.  The basic information displayed in the MBE fault codes window is limited to the code 
identification and the number of counts for that particular code.  Additional information as such as the time and date 
stamping the fault code start, finish, and total duration is not available.  

 
Useful facts to remember when using the MBE fault codes window: 
  
1. Active codes are identified by the red light to the left of the fault description.   
2. MBE fault codes are identified by standard SAE PID or SID numbers and their companion failure mode indicator (FMI).   
3. There are no flash codes identified with the MBE system.   
 
IMPORTANT NOTE ON MBE ELECTRONIC TROUBLESHOOTING 
Beginning with DDDL 6.3, an in-depth troubleshooting tree for the MBE system is now available. In versions prior 
to 6.3, “Troubleshooting Help” will only link to complete code description list.  
 

 

Although a troubleshooting 
tree was not available in 
versions prior to 6.3, 
additional MBE information 
is available in the MBE 
Electronic Controls section of 
Help and on the DDDL CD-
ROM. This material includes 
pin-outs, wiring diagrams, 
and information on the 
operation and setting up of 
important MBE electronic 
features. 
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DDEC CYLINDER CUTOUT BASICS 

 
1. From the Diagnostics drop-down menu select the “Cylinder Cutout” option.  The cylinder cutout screen in the figure 

above will appear on your screen. 
2. Fill in the options on the cutout screen for the type of test you would like to run. 
3. Run the test.  When the test results are complete (see the figure below) it is a good idea to print them.  (If you are not 

connected to a printer, see the section on how to print offline.) 
4. For an interpretation of your results, check the Mechanical Troubleshooting section of Help. This option will supply 

further information on cylinder misfire due to a faulty fuel injector.

The cylinder cutout test 
can be a very useful tool 
for determining if an 
injector is malfunctioning.  
The test can be run in 
“Automatic” mode, which 
performs the cutout on 
each cylinder in succession 
or in the “Manual” mode 
where the user selects a 
specific cylinder prior to 
testing.  To perform a 
cylinder cutout test with 
DDDL, follow this 
procedure: 
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MBE CYLINDER CUTOUT TEST BASICS 
 
To start a Cylinder Cutout Diagnostic Test: 
 

1. The engine must be on. 
2. The engine must be at idle (no other option is available). 

 
This test continually measures the torque of the engine.  When a designated cylinder is switched off, the 
injector is disabled causing the engine speed to decrease.  The remaining cylinders will correct for the 
missing cylinder and return to the correct idle speed.  The change in engine torque will indicate the power 
loss of a particular cylinder. A low change in engine torque may indicate a faulty cylinder. 
 
Notes on MBE cylinder cutout:  

1. This test will check the baseline torque prior to each cylinder being cutout, unlike the DDEC test 
that only makes an initial baseline measurement.  Because of this, the test will take longer to run 
than a DDEC cutout test. 

2. The results of the test should be evaluated by the relative torque value of each cylinder (not 
the baseline value in the lower left of the window). A significantly lower value indicates this 
cylinder may have a problem. 

3. In Automatic mode, the test runs through each cylinder one at a time and measures the torque as 
each one is switched on and off. 

4. In Manual mode, the user may switch the selected cylinder on or off as desired. The torque will be 
measured in the same manner for both types of tests. 

5. Upon exiting the test, all cylinders are automatically turned back on.   
 
Below are the results of 2 tests. The first test shows all cylinders working correctly. The second indicates a 
problem with cylinder #1. 

 
Test one, with cylinders operating correctly. 
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Test two, with a potential fault in cylinder number 1. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 38

 
THE MBE SERVICE ROUTINES WINDOW 
 
There are 5 diagnostic routines built into the PLD module.  The cylinder cutout routine has its own menu 
selection; the voltage test is located as a tab in the diagnostic instrumentation window, while the remaining 
routines (compression test, idle speed balance, and impact delay times) are contained in the service routines 
window. 
 
The Compression Test 
 

 
 
Running the compression test: 
 
1. To begin, select the “Service Routines” option from the Diagnostics drop-down menu; choose the 
compression test tab  
 
2. Make sure that the engine is turned off; then turn key to the “On” position 
 
3. Click on the “Run Test” box 
 
4. Crank the engine; the test is run during the cranking process, the engine will not start, when the test is 
completed the results will appear. 
 
Note: The cranking time required to complete the test should not exceed 40 seconds. If the test results 
do not display within this period, there may be other circumstances that are not allowing the test to 
be completed. In this case, please consult Detroit Diesel Technical Support for assistance. 
 
 
  
 
 
 

The compression test is a 
relative measure of 
compression on all cylinders. 
The test selects the cylinder 
with the “best” value to 
represent 100%.  The values for 
the other cylinders are listed 
relative to cylinder receiving 
the 100% rating. 
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The Impact Delay Time Test 
 

 
 
 
The Idle Speed Balance Test 
 

 
 

The impact time represents the 
time from the actuation of the unit 
pump until the valve body is 
recognized as being closed. 
 
The PLD measures these times 
continuously - the figures shown 
in the dialog are the averages of 
the most recent measurements at 
the time the dialog box is opened. 

Smooth idling control is always 
active. The results of the Idle 
Speed Balance test shows for 
each cylinder the deviation value 
required to balance idle speed.  
 
A deviation of 5% or more gives 
a fault code of 128 00n 12, where 
n is the cylinder number. 
  
Deviations at one cylinder only 
suggest an error condition. 
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THE INSTRUMENTATION WINDOW 
 
The Instrumentation window is displayed when you choose “Normal Instrumentation” or “Diagnostic 
Instrumentation” from the Diagnostics menu. The window displays live data measurements from the ECM 
connected to your PC.  The first picture below show the options available from the normal window.  The 
second shows the options available in the diagnostic window.  The natural gas option was added to the 
diagnostic window in version 4.10.  The EGR window was added in version 4.20. The List window was 
added in version 5.0. 
 
DDEC Instrumentation Windows (Normal and Diagnostic) 
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DDEC Instrumentation Window Features  
 
The normal instrumentation window is also displayed when you choose “Open” from the Snapshot menu 
unless the Fault Codes window is already open.  
 
When you have an open snapshot and the Instrumentation window is selected, playback controls are added 
to the bottom of the Instrumentation window.  You can use these to replay the snapshot.  The 
Instrumentation window is used in the same way whether you are viewing live data or a snapshot. 
 
Instrument Pages 
 
The instruments in the Instrumentation window are grouped together on tabs.  You can choose how they 
are grouped by choosing Normal Instrumentation or Diagnostic Instrumentation commands in the 
Diagnostics menu. 
 
To view the different pages of data shown in the window, click on the tab labeling the page holding the 
data.  You may also hold the “Control” key down while you press the number key shown on the tab. 
 
Note that you can customize the information shown in the Instrumentation window using the Graph or User 
pages. 
 
Multi-ECM Engines  
 
Provided you are using a PC display with a resolution of at least 800 X 600 (small fonts), some of the 
Normal Instrumentation pages show details for each of the ECMs in a multi-ECM engine. 
 
Note that whatever the resolution of your display you can also monitor parameters in the different ECMs by 
assigning them to instruments on the User pages or by choosing them for display on the Graph page. 
 
Instruments 
 
The results of measurements are presented in a variety of ways, depending on the quantity measured.  
 
You can tell from an instrument if the ECM is not transmitting data for that measurement.  The way "No 
Data" is shown depends on whether the instrument is: 
- a meter 
- a thermometer 
- a digital meter 
- text 
 
Magnified View of Instruments 
 
To display a magnified view of just one of the instruments on your screen, click on the instrument to 
enlarge it; click on it again to return it to the normal size. (this is particularly useful if you want to monitor 
a measurement while you are working at some distance from the display): 
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Instrumentation Window for MBE 
 
The Instrumentation window is displayed when you choose Normal Instrumentation or Diagnostic 
Instrumentation from the Diagnostics menu. The window displays live data measurements from the ECM 
connected to your PC.  The Instrumentation window is also displayed when you choose Open from the 
Snapshot menu unless the Fault Codes window is already open.  When you have an open snapshot and the 
Instrumentation window is selected, playback controls are added to the top of the Instrumentation window. 
You can use these to replay the snapshot. Otherwise, the Instrumentation window is used in the same way 
whether you are viewing live data or a snapshot. 
 

 
 
The instruments in the Instrumentation Window are grouped together on pages. You can choose how they 
are grouped by choosing Normal Instrumentation or Diagnostic Instrumentation commands in the 
Diagnostics menu. 
 
To view the different pages of data shown in the window: Click on the tab labeling the page holding the 
data, or hold the Control key down while you press the number key shown on the tab. 
 
Note: The pages are designed to cover all MBE configurations. This means that some instruments 
may not show a value on your particular system because they are not relevant to it  
 
The following pages are available in the Instrument window for MBE engines: 
 
Normal Instrumentation  Diagnostic Instrumentation 
Mechanical   Power 
Pressure    Brake 
Temperature   Fan 
Status    Misfire 
Graph    Smoke 
User    Sensor Voltages 

Cruise Control / PTO 
Switches 
List 
Graph 
User 
EGR 

 
 

Complete examples of the MBE 
screens appearing in the 
instrumentation section may be 
found in the Help section of 
DDDL. 
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Notes on MBE Instrumentation:  
 
1. The Graph and User pages appear in both the Normal and Diagnostic Instrumentation modes - they allow 
you to customize the information shown in the Instrumentation window. 
 
2. The List tab allows you to view all the MBE diagnostic parameters in one scrollable list organized by 
functional groups. 
 
3. The tab displays all the possible sensors that may be configured on a variety of MBE engine 
applications. Some sensors do not provide data on some engine configurations. Please consult your engine 
documentation or you Detroit Diesel engine specialist for specific details on your engine. 
 
4. The results of measurements are presented in a variety of ways, depending on the quantity measured.  
 
5. An instrument will show “No Data” if for any reason the ECM is not transmitting data for that 
measurement. The way "No Data" is shown depends on whether the instrument is: 
 

- a meter 
- a thermometer 
- digital meter 
- text. 

 
6. To display a magnified view of just one of the instruments on a data page (this is particularly useful if 
you want to monitor a measurement while you are working at some distance from the display). Click on the 
instrument; click again to return to the normal size view. 
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ENGINE CONFIGURATION DATA 
 
The DDEC Configuration Window 
 
The procedure below allows you to display basic configuration data for the engine and ECM.  The Engine 
Configuration Data window is also displayed automatically if the PC is connected to an ECM when you 
click on “Close” in the Welcome screen. 
 
1. Choose “Engine Configuration Data” from the Diagnostics menu to display the Engine Configuration 

Data window: 
 

 
2. Click on the ECM data tab to view configuration information for the ECM (or ECMs in a multi-ECM 
engine). 

 
1. Click your mouse on “Close” to close the Engine Configuration Data window. 
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The MBE Engine Configuration Window 
 
The MBE window operates in the same manner as the DDEC window.  It displays basic configuration data 
for the engine and ECM as shown below.  There is only one tab of information displayed on the MBE 
window. The Engine Configuration Data window is also displayed automatically if the PC is connected to 
an ECM when you click on “Close” in the Welcome screen.   
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ECM I/O CONFIGURATION (DDEC III, IV, & V) 
 
The DDEC III and IV Window 
To examine the status of switches, the ECM input and output function configuration, or to set the output 
function values temporarily for testing, follow this procedure. 
 
1. Choose “ECM I/O Configuration” from the Diagnostics menu to display the ECM I/O Configuration 

dialog box.  (For multi-ECM engines, the input and output function configuration of each ECM is 
shown on a separate page.) 

 
2. Test an input by changing the position of the switch.  When a vehicle switch has been activated or 

turned off (for example, the parking brake switch), the status of the associated input will change. 
 
3. To set an output function temporarily for testing, click on “Activate Outputs” to display the Activate 

output dialog box. 
 
4. Beginning with DDDL 4.1, a user may save the current ECM I/O configuration as a text file. Click 

once on the “Save” button and you’ll receive confirmation that the information was saved to a text file 
with the name of the engine serial number. 

 

 
REMINDER: THIS FEATURE DOES OPERATE WITH A DDEC II ECM 
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The DDEC V I/O Window 
One of the biggest changes to the DDEC V ECM is the number of digital inputs and outputs have greatly 
increased.  The I/O screen for DDEC V has been changed to accommodate the increased values: 
 
DDEC V INPUT SCREEN 

 
 
 
DDEC V OUTPUT SCREEN 

 
 
 

As with other 
versions of 
DDEC the 
inputs are 
listed for 
informational 
purposes only 
and may not 
be changed 
with DDDL.  
This 
information 
may be 
printed or 
saved to a 
text file by 
selecting the 
appropriate 
boxes in the 
lower portion 
of the screen. 

The outputs 
settings may 
also be saved to 
a text file or 
printed by 
selecting the 
appropriate 
boxes in the 
lower portion of 
the screen.  
Highlighting the 
output in the 
list, selecting 
the state you 
wish to place 
the output in, 
and then 
selecting the 
“set” box may 
activate outputs. 
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VIEWING INJECTOR RESPONSE TIMES (DDEC ONLY) 
 
You can use DDDL to view the fuel injector response times.  Choose “Injector Response Times” from the 
Diagnostics menu to display the Injector Response Times dialog box. 

 
The cylinders for the other ECMs in multi-ECM engines will be shown below the master ECM cylinders.  
When viewing cylinder numbers in engines with "V" configurations, the side of the engine the cylinder is 
located on will be designated as either Left or Right (such as cylinder 2R) or as A or B cylinder (such as 
cylinder 2A).  For more information on cylinder numbering and identification, please refer to the specific 
engine service manual. 
 
THE MAINTENANCE ALERT SCREEN (DDEC ONLY) 
 
The final selection in the Diagnostics drop-down menu is titled “Maintenance Alert.”  When you make this 
selection the following screen appears: 

 

This screen displays information on two distinct items:   
 
1. It displays the status of the sensors in the Detroit 

Diesel Maintenance Alert System (MAS).  MAS 
is an optional feature consisting of a set of sensors 
and a cab-mounted display unit.  This display 
allows you to view the status of the parameters 
MAS monitors and to reset the cab display if 
maintenance has been performed on these 
parameters. 

 
2. You can monitor the status of three Preventative 

Maintenance (PM) items that can be set up 
through DDEC Reports.  For more information on 
setting up the PM feature see DDEC Reports Help.     
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VIEW OBSERVED MIDS (DDEC AND MBE FEATURE)  
 
Beginning with version 4.1 you may view a list of all the Mids (Message Identifiers) that have been 
observed communicating on the link since the connection was last made.  Choose View Observed Mids 
from the Diagnostics menu to display the Observed Mid List dialog box: 

 
Press OK to close the dialog box and return to the main window. 
 
EXHAUST BACKPRESSURE FAULT TIMES (DDEC Only) 
 

 
 
CLEAR THE AFR LEARN TABLE (DDEC Only) 
 
The air /fuel ratio table is component on DDC natural gas engines only.  To clear the table, go to the Tools 
menu and select the Clear AFR Learn Table option.  When the operation has been performed you will 
receive this message: 
 

 
 
 
 

Beginning with version 4.20 you may view 
the exhaust backpressure fault times on DDC 
Series 2000 and 4000 series engines that 
support this feature.   Choose Exhaust 
Backpressure Fault Times from the 
Diagnostics menu. 
 
NOTE: The Min and Max values for exhaust 
back pressure PID 81, FMI 0 (code77) reset 
when the ignition is cycled. The Pro-Link 
reader retains the maximum value seen. 
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The Particulate Filter “De-greening” Process 
 
Certain transit bus calibrations work with particulate filters in order to meet emission standards. When a 
new particulate filter is installed part of the set up process involves running the “de-greening” option now 
available in DDDL 6.3.  
 
When a new particulate trap filter is installed, the exhaust backpressure limit triggers a PID 81 indicating 
excessive exhaust backpressure. This increased threshold is applied for the first 4000 vehicle miles after the 
filter is installed.   
 
If this fault code is not addressed within 50 hours after installation by running the de-greening option, the 
SEL will illuminate and register a SID151 FMI 11, which is a "Service Now Lamp Fault Expired" code. 
PID 81 will re-occur each time the key is cycled unless the de-greening process has been started. 
 
To run the de-greening process in DDDL: 
 

 
 
 1. From the tools drop-down menu choose the “Particulate Filter De-green Reset” 
 
  

                                         
 
2. A message will appear in the center of the DDDL screen asking the user to confirm that the process 
should be initiated. 
 
 

                               
 
3. The user will receive a message confirming that the process has been completed. 
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4. The user may review how many miles the engine has run since the last de-green process was completed 
by choosing the “Engine / Trip Data” option form the “Tools” drop-down menu. The information is 
contained on the “Engine Totals” tab in the lower right corner. 
    
 
 
 
 
Recalibrate NG Oxygen Sensor   
 
Users of DDDL 6.3 that have natural gas engines may now manually recalibrate the oxygen sensor. To use 
this function please follow these steps: 
 

 
 
I. Go to the “Tools” drop-down menu and choose the “Recalibrate NG Oxygen Sensor” item.  This item 
will only be available for use with DDEC natural gas engine and will appeared “grayed out” in other 
DDEC application, 
 
II. A message will appear with instructions for preparing the sensor to be recalibrated. Once this is done 
simply click on the “OK” box to recalibrate the sensor. 
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III. If the operation is successful you’ll get a message back acknowledging that the operation is complete. 
     

                                                
 
If there was a problem with the operation a message will appear informing the user that the operation was 
not successful and giving the user possibilities as to why the operation was not successful.  For further 
information on successfully completing this operation please call Detroit Diesel Technical Service. 
 

 
 
 
Recalibrate EGR Delta Pressure Sensor (Applies to DDECIV and DDECV) 
 
From the Tools menu, select Recalibrate EGR DP Pressure Sensor. 
 

 
 
 

EGR Delta Pressure Sensor Recalibration Procedure 
 
NOTE:  This feature can only be accessed if your DDECV ECU has been updated to the 
latest R3.00 software.  If it has not, the ECU will need to be reprogrammed. 
 

1) With your DDECV ECU connected, open Diagnostic Link. 
2) Close the Welcome screen and the Engine Configuration screen. 
3) From the Tools Menu, select Recalibrate EGR TP Sensor to display the message 

shown below. 
4) Click OK or Cancel. 
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5) A successful recalibration will be followed by this message. 
 

 
 
 
 
There may be instances where the Recalibration process will fail in which case one of the following three 
messages will be displayed. 
 
A)  If you get this message, either the vehicle is running or the ignition is not turned on. 

 

 
 
 

B) This message in an indication that your DDECV ECU may need to reprogrammed to the 
current R3.00 software.  If you need assistance with this process, please call our Customer 
Support Center at 313-592-5800. 
 

 
 
 

C) This message is an indication that there may be a problem with the Delta Pressure Sensor.  Checking 
any related fault codes will assist you in troubleshooting the issue. 
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Engine / Trip Data Options 
 
To access basic engine trip information with DDDL, go to the Tools drop-down menu and select the 
“Engine / Trip Data” option.   A screen with two tabs will appear.  The first tab contains the current stored 
trip data values, while the second tab contains the totals for the life of the engine. 

Exporting the engine/trip totals in versions prior to DDDL 3.1: 
1. Press “Export” in the Engine/Trip Data dialog box.  You may export data from all DDEC ECMs.  If 

you are using a version of DDDL prior to 3.1 the current trip could only be cleared on a DDEC II or III 
equipped vehicle. After the data has been exported, you will be asked if you want to reset the trip.  

Exporting the engine/trip totals in versions DDDL 3.1 and later (DDEC Only): 
1.  With versions of DDDL 3.1 or later, the Export option remains the same for DDEC II and III. In 
addition, you have the option to reset DDEC IV / V trip data after a successful export.  When you choose to 
export DDEC IV trip data you will see the following message: 

2. If the Vehicle Unit Number in the ECM is blank, or you have DDEC II or III ECM software earlier 
than version 4, you will be asked to enter the Vehicle Unit Number.  In DDEC III the Vehicle Unit 
Number is separate from the Vehicle Identifier. (The latter can be set and viewed in Detroit Diesel 
Communications.)  However, the Unit Number and Identifier are the same in DDEC IV /V. For a 
complete discussion of the data file created by the export function, read “Understanding CSV Files.” 

UNDERSTANDING CSV FILES 
 
Where does the data I export in DDDL go?   
 

The export feature may be 
used in DDDL 5.0 or later 
on MBE VCU modules 
with software level 12.09 
or higher. You may not 
reset the trip data with this 
feature on MBE engines. 
Trip data may only be reset 
by performing an 
extraction with DDEC 
Reports.  



 55

Exported data is sent to a file with a .csv extension. 
 
What do these files contain and how can I look at them?  
 
CSV files are simply files that contain engine trip data that can be loaded into commonly used spreadsheet 
programs.  Consult the help section for the spreadsheet program you are using for opening CSV files.  
 
Where are these data files located?  
 
The CSV files DDDL creates are found in the C:\Detroit Diesel\Diagnostic\Report directory.   There are 
four files in this directory when the program is first loaded.   
1. _exp_dp.csv 
 
2. _exp_acc.csv 
 
3. exp_dp.csv 
 
4. exp_acc.csv 

 
What information is in each of these files? 
 
1. The files with the “_” in the front of the name are templates for how the columns of data are setup and 

never contain any data.  Do not open these files. 
 
2. When you choose to export data from the Engine/Trip data section of DDDL, the information is 

transferred to a new row in the exp_acc.csv file.  Every time a new export occurs a new row of 
information is added to the exp_acc.csv file.  

 
3. Data is added to the exp_dp.csv file every time a DDEC Reports extraction is made.  Essentially the 

same data that appears in the trip activity report in DDEC Reports is placed in a new row of the 
spreadsheet.  The next time an extraction occurs another line of data is added.  Every time a DDEC 
Reports extraction is successfully completed an .xtr file is made and a row is added to exp_dp.csv.   

 
What is the main purpose of the CSV files? 
 
Information gathered on the entire fleet can be summarized and analyzed using all the capabilities of your 
spreadsheet program. 
 
Are there any other special features regarding CSV file? 
 
1. At the end of a calendar month the CSV files are automatically renamed and stored in the same 

directory.  This process occurs when you complete the first export or extraction in the next calendar 
month.  The exp_acc.csv and exp_dp.csv are cleared and begin to collect data for the new month.  
These CSV files are useful for fleets that wish to summarize vehicle activities.   

 
2. Do not save the original CSV file when it is opened up in the spreadsheet.  If you do, you will alter 

the dating mechanism that detects the end of the month.  If you wish to save your spreadsheet 
information, use the “Save as” selection and save the file under another name.  Leave the original CSV 
file alone.  Saving the original CSV file within the spreadsheet causes problems with the automated 
features of the CSV file. 

 
3. An important utility for creating CSV data files from .xtr and .dhp files is available in DDEC Reports 

3.1or later.  For detailed information on this feature see the "CSV Creation Utility" section in this 
guide. 

 
4.    The data format of CSV files is English units only, regardless of the DDDL’s unit settings. 
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CONFIGURING DDDL TO PRINT OFF-LINE  

Setting up your Printer 
 
1.  Setup your printer to work offline by clicking on “Start,” selecting “Settings,” and selecting 

“Control Panel.” 
 
2.  Select “Printers.” 
 
3.  Highlight your desired printer. 
 
4.  In the File menu, place a check by “Work Offline” by selecting it with your mouse.  (Some 

computers may not have the “Work Off-line” option.  “Pause Printer” can be selected and 
will perform the same function.) 

 
 

 
 
 
 In the example below we will send the engine configuration data to the printer to be stored and 
printed at a later time.  The process will work with any DDDL screen that displays the option to 
print.   

Saving Data to the Print Queue. 
 
1. Connect your PC through a translator box and cables to the diagnostic connector of a truck. 
 
2. Start the Detroit Diesel Diagnostic Link software. 
 
3. The Welcome screen shown below will be displayed. 
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4. Close the Welcome screen. 
 
5. The Engine Configuration screen will be displayed. 
 

 
 
6. Choose “Print.” 
 
7. The Print screen will be displayed. 
 



 58

 
 
8. Choose “OK” to save the Engine Configuration to the Print Queue. 

 Print the Stored Data 
 
9. When you have saved all the Engine Configuration screens you wanted to, go into the 

Control Panel and disable the “Work Off-line” or “Pause Printing” option.  The next time you 
turn on your computer, you will be prompted to print. 

 
10. When ready to print, connect your printer to the PC before you turn it on. 
 
11. Print the Data. 
 

  
 
 
 
 
Note:  You may use the same procedure to print any DDDL data screen offering the 
print option. 
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DROP-DOWN MENUS IN DDEC REPORTS 6.3 (DDEC & MBE) 
 
File           Connect                    
    Open                                     Communications Manager 
    --------             ----------------------------------- 
    Print               Setup Vehicle After Extraction 
    Print Preview                  
    Print Setup 
    Print All 
    --------- 
    list of recent files  
    --------- 
    Exit   
 
View                  Tools 
    Activity >           Diagnostic Link 
    Speed/RPM >           --------------------- 
    Load/RPM  >           Extraction Log 
    Over Speed/Over Rev                           Vehicle Registry 
    Vehicle Configuration                        Vehicle Parameters 
    ------------------------------                       ---------------------- 
    Periodic Maintenance           Options 
    DDEC Diagnostic Records                   ----------------------- 
    Hard Brake Incidents   >                       Archive Extraction Files 
    Last Stop Record         >                       Export Data to CSV 
    Profile           ------------------------               
    Daily Engine Usage     >                      Select Application 
    Life-to-Date 
 
 
Help 
    Help Topics 
    ----------------------- 
    About DDEC Reports… 
 
 
 
VIEWING DATA FROM COMPLETED EXTRACTIONS 
 
In order to view the various reports available in DDEC Reports, you must open a file from a successful 
extraction.  A trip or period activity report will automatically appear on your screen after a successful 
extraction or you may open a previously extracted set of data by going to the File drop-down menu and 
selecting the "Open" option.   
 
Once the initial report is displayed, you may view any of the other reports by accessing the “View” drop-
down menu and choosing the type of report from the list displayed.   An arrow next to the name of the 
report in the menu indicates there is more than one way to display the data.  For example, a Hard Braking 
incident can be displayed as a table of numbers or as a graph.  If an item in the View menu is "grayed out,” 
it means there is no data available in this extracted file to create a report for this item.  The reports available 
will vary from vehicle to vehicle depending on the software level, options selected in the calibration, and 
the version of DDDL with which it was extracted. 
 
Selecting “Print” from the file drop down menu may print any report displayed on the screen.  Beginning 
with DDEC Reports 4.1 there is an additional option to print all the reports available in that file.   
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HOW TO EXTRACT TRIP DATA FROM A VEHICLE AND CREATE 
REPORTS 
 
INITIALLY SETTING UP COMMUNICATIONS MANAGER  
Before you begin your first extraction, follow these steps to set the Communications Manager to pop-up 
and allow you to view the progress bar during the extraction.  You can perform these steps from either the 
DDDL or DDEC Reports program. 
  
1. Go to the Tools drop-down menu. 
2. Select the “Options” item. 
3. Select the “Communications Manager” tab. 
4. Change the option in Windows Pop-up Preference from “Never” to “On Extraction.” 
5. Click on the “OK” box at the bottom of the dialog box. 
6. Exit the program.  When you re-start DDEC Reports you will be ready to begin. 
   
Important Note: The vehicle must contain a Detroit Diesel engine with a DDEC ECM or an MBE engine 
with a VCU module with 12.09 or later software.  A DDEC III ECM must be Release 5.0 or higher and 
Data Pages must be turned on.  All DDEC IV and V ECMs can be extracted but some data is not available 
in DDEC IV modules with Release 20.  MBE extractions may be performed with DDEC Reports version 
4.1 or later. 
 
THE EXTRACTION PROCESS 
 
1. Plug the Detroit Diesel translator box cable into the vehicle 6-pin or 9-pin diagnostic connector.  Connect 
the cable from your computer to the translator box. 
 
2. Starting from the main Windows desktop screen use your mouse and left click once each on the 
following items:  Start, Programs, Detroit Diesel, and finally DDEC Reports 
 
3. This will bring up the DDEC Reports program.  When the program first opens you will see the drop- 
down menus, the icon toolbar, and a blank white screen below (for versions 3.0 and earlier) or a start menu 
screen (for versions 3.1 or later).  Close the start menu if you have one. You’ll notice a blank gray box 
under the File drop-down menu in the icon bar.  This icon is identified as the Communications Manager. 
 
4. Turn the vehicle ignition on.  A small tri-colored light will appear in the previously grayed out 
Communications Manager icon box within 15 seconds. 
 
5. With your mouse, left click once on the Communications Manager icon at the left end of the tool bar.   
This will initiate the extraction process.  You will see a message on the screen: “Communicating with 
vehicle, please wait.”  
 
6. If this is the first time the vehicle has been connected to the computer you are using, an Unknown 
Vehicle ID box will open (usually in 30 seconds or less).  Type the vehicle ID into the Add/Assign Vehicle 
ID dialog box and click “OK.” 
 
7. You will see a blinking amber light in the traffic light status box indicating that data communication is 
taking place.  Status bars in the window will show progress for the devices being extracted. 
 
8. The traffic light will turn green in a few minutes and a dialog box will appear (in versions 3.1 and 
earlier) stating that the extraction was successful.  Click “OK”.  In version 4.1 or later the activity report 
appears automatically.  
 
9. The Trip Activity report will appear on the screen automatically.  You may choose other reports by 
clicking on the various report icons on the tool bar or by selecting from the View menu.  The View menu 
contains some report options not represented by icons on the tool bar. 
 
If you experience any problems with extractions you may wish to review the material in the DDDL CD    
covering common extraction problems or call the DDC Helpdesk for assistance.   
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OPTIONS FOR CLEARING TRIP DATA IN DDEC REPORTS 4.1 & 
LATER (for both DDEC & MBE Systems) 
 
Whenever you complete a successful extraction of trip data in DDEC Reports, the default settings in 
the program reset the trip data registers.  However, there are cases when you may wish to extract the 
information from a vehicle and not reset the trip data.  Follow these steps in DDDL version 4.1 to set up a 
single vehicle so that trip data does not get cleared: 
 
1. Open up DDEC Reports and go to the “Tools” drop-down menu. 
 
2. From the “Tools” menu, select “Vehicle Registry.” 
 

 
 
3. The Vehicle Registry Editor will appear on your screen.  If you have already extracted data from this 
vehicle before, double click with you left mouse button on the vehicle you wish to modify in the “vehicle 
ID” column and you’ll be taken to the “Vehicle Details” screen (move directly to step 5).  If you have never 
extracted data from the vehicle before, you’ll need to set up the vehicle in the vehicle registry. Click on the 
truck / plus sign icon and you’ll be prompted to enter the vehicle ID.  
 

 
 
 
Enter the ID.  (If you want to check for an existing Vehicle ID, you can retrieve the calibration in DDDL 
and check the “Vehicle Unit Number” on tab 1 prior to beginning this process.) Click on “OK”. 
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4. You will see a screen asking you to identify the devices you will be extracting from on this vehicle.  
Typically this will be a DDEC ECM.  If you are setting up a unit with an MBE engine you should also 
select the DDEC option. When you have filled in the correct device(s) click on “OK” in the “Add Device” 
box.  The Vehicle Details screen for the vehicle you have just set up will appear.  

 
5. The “Local Extractions” section located in the lower left of the Vehicle Details screen contains the 
options for customizing the data to be extracted.  When the screen initially appears these options appear to 
be “grayed out” or inoperative. To enable choices among the options, click once with the left mouse button 
on the “Edit” box in the upper right side of the screen. (Those familiar with earlier versions of DDEC 
Reports will notice the “Vehicle Details” screen has been re-designed in version 4.1.)  

 
You may now disable the reset action on this vehicle by removing the check from “Reset Trip” box. (For 
more detailed information on all the choices available concerning data extraction see the Detroit Diesel 
Communications Help.) When you’ve finished making your selections, click once with the left mouse 
button on “Apply” in the upper right of the window, and then select “OK” with the left mouse button. For 
details on setting up trip clearing options on versions of DDDL 3.11 or earlier, see the Documents section 
of your current DDDL CD. 
 
 

Note on the Vehicle 
Details Screen for 
MBE users: 
The details for 
MBE  units in the 
vehicle registry will 
appear on the tab 
labeled DDEC IV. 
The software 
version will display 
the correct 
software version of 
the VCU module 
after the first 
extraction has been 
made from that  
unit. 
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DDEC REPORTS INFORMATION AND TIPS 
 
 
1. CAUSES OF FAILED EXTRACTIONS 
 
If you failed to successfully extract your data, please review the information below:  
 
A.  Extraction fails due to no Dataset Definition File (DDF file).  For versions prior to 4.10. 
 
If extractions fail repeatedly on a particular vehicle, go to the Tools drop-down menu and select the 
“Extraction Log Viewer.”  If the extraction record in the viewer indicates that the extraction failed due to a 
“bad data set,” close the Viewer and go to the Tools menu once again. Click on the “Vehicle Registry 
Editor” to open it.  Select the truck you are working with and double click the mouse pointer on that unit.  
You will see the Vehicle Details Screen.  Check the “Dataset Definition File” title shown in the 
corresponding box.  If “none” is displayed, click on the down arrow at the right side of the box and change 
to a selection with the word "trip" in the title.  Now retry the extraction. 
 
B.  Trip activity report with zeros 
 
If you have a failed extraction from a vehicle followed by a successful one, the trip activity 
report that pops up will show all zeros. However there is good information available to display 
if you know where to look: 

- The monthly portion of the trip activity reports has three months of data to view. 
- The daily engine usage report has the last 30 days of data available to view. 
- The configuration page has complete data. 
- The life to date page is also complete. 

 
C.  Mistaken use of the Profile extraction 
 
When making extractions with the translator box or the RDI, use DDF files with the word "trip" 
in the title.  The Profile extraction is a small subset of a trip extraction and is meant for wireless 
extractions only.  The Reset DDF file resets all ECM data without extracting a file. 
 
D.  Inadvertent extraction abort 
 
In versions prior to DDDL 3.0, you may inadvertently abort an extraction if you hit the “Enter” key after 
you have entered the vehicle ID instead of clicking on “OK” with your mouse. 
 
E.  Activating the communications manager the wrong way 
 
Only click on the small traffic light icon in the toolbar (along the top of the screen) to initiate the 
extraction process.  Be very careful to click on the icon only once.  Don’t click on the icon in 
the tray on the taskbar (bottom of the screen). 
 
 
2.  MISSING OR DUPLICATE DAYS IN REPORTS 
 
If days are missing or duplicated in the daily engine usage report, there is probably a conflict between the 
fleet time zone set in the ECM and the PC time zone that processed the file.  There are actually no days or 
data missing or duplicated.  The report disparity can be corrected by setting the time zone of the reporting 
PC to the fleet time zone.  Fleet time zone can be found in the Configuration Report.  The time zone can be 
set in DDDL. 
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3. INFORMATION ON USING DDEC REPORTS TO OBTAIN MBE ENGINE DATA 
 
The ability to gather fleet management information, similar to DDEC Data has been added to engines 
equipped with MBE electronics VCU modules programmed software version 12.09 or higher. This 
information may be extracted and reports made with DDEC Reports 4.1or higher.  Here are some things to 
remember about 12.09 data extractions: 
 
1. The initial date stamp for the first extraction you perform will probably show the year 2027. This 
condition is similar to the first extraction from DDEC III Data Pages showing a 1985 date. The updating of 
the clock at the time of the extraction will correct this issue. 

 
2. The first extraction after an upgrade may also contain corrupted data. This would be due to not having 
gathered information correctly with earlier versions of software. Once again this condition will be corrected 
after the initial trip data is reset. 

 
3. DDEC Reports 4.1 or later is the only software that currently can extract data and create reports. At the 
current time Data Summaries does not work with the MBE data. 
 
4. Extractions of MBE data will produce an XTR file with the same naming conventions and default 
location as a DDEC IV extraction. 

 
5. The setting for top gear –1 is not being currently set at the factory. The parameter (11608 in VCU 12 
software) may be set with the Minidiag, Pro-Link card for the MBE, and DDDL. 
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AN OVERVIEW OF DATA EXTRACTION FILE TYPES 
 
There are several devices within the Detroit Diesel product line that collect trip data for extraction. The 
data you extract is automatically saved with a file name that indicates which device collected the trip data. 
Different file types are stored in different folders. Here is an expanded view from Windows Explorer 
showing the folder structure where extracted trip data files are stored. 
 

 
DDEC IV, DDEC V, and ProDriver 3.0 Files (.xtr) 
 
Trip data from DDEC IV/V and from ProDriver 3.0 is automatically saved in files with the extension .xtr. 
The .xtr files are stored in the Data Pages folder (C:\Detroit Diesel\Diagnostic\Data Pages). If both DDEC 
IV and ProDriver 3.0 are installed on the same vehicle, the data is saved in the same .xtr file. If only 
ProDriver 3.0 is installed on the vehicle, use ProDriver Reports 1.0 for data analysis and reporting. 
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Files for Exporting to a Spreadsheet (.csv) 
Extracted DDEC data is also automatically saved in .csv files that can be exported to a spreadsheet. The 
.csv files contain all the extracted files for the current month. At the end of the month, the current month 
files are closed and renamed for archiving. The .csv files are stored in the Report folder: C:\Detroit 
Diesel\Diagnostic\Report. 
 
The files _exp_acc.csv and _exp_dp.csv contain information used in formatting the spreadsheet. Do 
not open the files that begin with the underscore character ( _ ). 
 

There are two export files for the current month: exp_acc.csv and exp_dp.csv.  (Note: There is no initial 
underscore in the file name.)  The two files contain different information, so both files can be exported 
when doing spreadsheet analysis.  The .csv files are comma separated value files. 
 
The two files starting with Po are archived data files. The file name is written as: 
 
Po YY MM DD . csv 
 
YY is the last two digits of the year 
MM is the month expressed as a number 
DD is the day of the month for the first extraction in the file 
 
Example:  Po990802.csv contains all extraction data for all vehicles for the month of August, 1999.  The 
first extraction in the file was done on 8/2/99. 
 
ProDriver 2.x Files (.pm1) 
Trip data from ProDriver 2.x is automatically saved in files with the extension .pm1.  The .pm1 files are 
stored in the transit folder: C:\Detroit Diesel\Communications\transit. The files would have to be processed 
with ProDriver Reports and then analyzed in that application. 
  
DDEC III and Data Logger Files (.dhp) 
Trip data from DDEC III and from Data Logger is automatically saved in files with the extension .dhp.  
The .dhp files from DDEC III are stored in the Data Pages folder: C:\Detroit Diesel\Diagnostic\Data Pages.  
The .dhp files from Data Logger are stored in the transit folder: C:\Detroit Diesel\Communications\transit. 
Use ProManager 2.02 for data analysis and reporting on Data Logger files. 
 
Extraction Log Files (.elg) 
.elg files are Extraction Log Files.  At the beginning of each month, Communications Manager 
automatically removes the extraction log data for the month before the one that has just finished and 
archives it in a separate extraction log file.  Use the Extraction Log Viewer to open .elg files. 
 
Setup Files (.dhe and .csf) 
.dhe and .csf files are setup files created from saved selections in Vehicle Parameters. 
 
Log Files (.log) - Log files are used by Detroit Diesel Technical Support. 


